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Introduction 

Do you buy and sell products that come in a variety of sizes and colors?  Do your Customer 
Service Reps need to enter orders quickly, while on the phone?  Resolv Style provides a quicker, 
easier way to enter items on sales and purchasing documents by means of a style grid.  Each 
part number and color can be entered on a single line, with all of the required sizes.  Operators 
can quickly quote prices, recap the order, verify quantities, and check to see if all items are 
available for shipment – all from a single screen!  The order is then transferred into a standard 
SAP Business One Sales Order or Purchase Order document with the click of a button. 

Resolv Style is also used in Inventory Transfers, Inventory Transfer Requests, Goods Issue and 
Goods Receipts. 

Note: Although this manual uses references and terminology relating to the clothing 
industry, Resolv Style is suitable for companies selling many types of products.  The 
program is adaptable to any items that are available in a range of attributes.  For 
example: 

Fastener products that are sold in a range of sizes, finishes, thread types, etc. 
(screws, washers, etc.) 

Plant nursery products that are sold by species, variety, and color (trees, flowers, 
etc.)  

Building materials that are sold by material type and color (roofing tiles, siding, etc.) 
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Summary of Features 

Style Entry 

From the Sales Quotations, Sales Order, Purchase Order Screen, Inventory Transfers, Inventory 

Transfer Requests, Goods Issue and Goods Receipt, tab into the Style Entry Matrix 

Enter each style/color on a single line, then enter quantities for all desired sizes 

Total quantity and value for each line is shown 

Total quantity for each size is shown 

Pricing (Sales Only) 

See prices for all valid sizes of each style/color 

Instant quote to customer on phone 

Seasonal “Early Buy” pricing options 

Availability (Sales Only) 

See available quantity of all valid sizes of each style/color 

Instant verification for customer on phone 

Detail 

Breakout list of all ordered styles by color and size 

Recap for customer on phone 

Order History (Sales Only) 

Lists all items previously purchased by customer 

Drill-down to prior orders 

Item Check (Sales Only) 

Before exiting screen, verify that items are available for expected ship date 

Change delivery date if necessary – system shows when item is due into stock 

Transfer to Sales/Purchase Order 

Items are transferred to the Business One Sales Order or Purchase Order document 

Each style/color/size is on a separate line 
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Setups 
 
There are a few setup screens that are necessary in order to use the features of Resolv Style.   
 

Preparation 
 
Before making any entries in the system, you should give careful thought to the structure of 
your products.  Determine what attributes will be used to describe different variations of each 
product.   
 

Note: Not all items will have the same attributes.  Here are some examples: 
 

Shirts: style, color, size 
Pants: style, color, length, size 
Caps: style, color 
 

Second, determine which attribute will be used for entering quantities.  Most often this will be 
the size.  For example, you will enter the quantity of each size of style 1234 red shirts.  In the 
case of caps, as shown above, all caps would have a single size. 
 
Next, assign User-Defined Fields (UDF’s) on the Item Master table for each attribute.  The 
system will include pre-defined fields designated: AISSort1, AISSort2, AISSort3, and AISSort4.  
These may be used for the style attributes, or you may create your own UDF’s for this purpose.  
Be sure that the display name of the attribute is easily understood by the users.  You may enter 
valid values to ensure that correct information is entered consistently in the fields.  For 
example, to avoid multiple spellings and abbreviations of the word “black”, enter “BLK” as a 
valid value.   
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The user-defined fields are defined in Tools > Customization Tools > User-Defined Fields – 
Management.  An example is shown below: 

Your support consultant will be able to assist you in defining and entering the UDF’s. 

Note: It is not necessary to assign a UDF for the size or other quantity attribute. 

Finally, it is necessary to ensure that your Item Master contains a separate item code for each 
combination of attributes.  Thus, item 1234redXL would be style 1234 shirt, red, extra-large, 
and item 1234red2X would be style 1234 shirt, red, size 2X.  The actual format of the item code 
may be whatever you wish; it is simply necessary to have a different item code for each 
combination of style, color, and size that is included in your inventory.   

Style Defaults Entry 

Administration > Resolv Setup > Resolv Style > Style Defaults 

The Style Defaults Entry screen is used to set the formats and other preferences for the Style 
Matrix.  It consists of three tabs. 
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Form Layout Tab 

This section determines which viewing panes will be visible in the Style Matrix, and what they 
will be called.  Note that you may set any of the panes to “Not Used”, and it will not be visible 
or available to users.  The Pane Level would be changed to ‘0’ (not used). 

Use Matrix in Sales 
Quotations 

Check this box if you wish to use the Style Matrix 
when entering Sales Quotations. 

Automatically Start Style Check this box if you want Style to automatically open 
when you press tab on the Item field on the Sales 
Quotation instead of prompting the user to select 
Item or Style. 
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Use Matrix in Sales Orders Check this box if you wish to use the Style Matrix 
when entering Sales Orders. 

Automatically Start Style Check this box if you want Style to automatically open 
when you press tab on the Item field on the Sales 
Order instead of prompting the user to select Item or 
Style. 

Use Matrix in Purchase 
Orders 

Check this box if you wish to use the Style Matrix 
when entering Purchase Orders. 

Automatically Start Style Check this box if you want Style to automatically open 
when you press tab on the Item field on the Purchase 
Order instead of prompting the user to select Item or 
Style. 

Use Matrix in Inventory 
Transfer 

Check this box if you wish to use the Style Matrix hen 
entering Inventory Transfers. 

Automatically Start Style Check this box if you want Style to automatically open 
when you press tab on the Item field on the Inventory 
Transfers instead of prompting the user to select Item 
or Style. 

Use Matrix in Inventory 
Transfer Requests 

Check this box if you wish to use the Style Matrix 
when entering Inventory Transfer Requests. 

Automatically Start Style Check this box if you want Style to automatically open 
when you press tab on the Item field on the Inventory 
Transfer Requests instead of prompting the user to 
select Item or Style. 

Use Matrix in Goods Issues Check this box if you wish to use the Style Matrix 
when entering Goods Issues. 

Automatically Start Style Check this box if you want Style to automatically open 
when you press tab on the Item field on the Goods 
Issues instead of prompting the user to select Item or 
Style. 

Use Matrix in Goods Receipt Check this box if you wish to use the Style Matrix 
when entering Goods Receipt. 
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Automatically Start Style Check this box if you want Style to automatically open 
when you press tab on the Item field on the Goods 
Receipts instead of prompting the user to select Item 
or Style. 

Use Item Availability Check Check this box if you wish to utilize the Item 
Availability Check feature during the Matrix entry 
procedure.  This feature allows you to verify that 
items are not duplicated on the order, and that all 
items will be available by the specified delivery date. 
This feature is only available in Sales Orders. 

Require Availability Check Check this box if the Item Availability Check will be 
required for each order, before exiting from the 
Matrix. 

The following options relate to the five possible tabs, or panes, in the Matrix screen.  
You may determine which ones will be visible to the users, and in what sequence. 

Item Entry Pane Level Select the sequence number (from 1 to 5) for the 
pane on which the user enters the items for the sales 
order.  You may also select 0 – Not Used. 

Entry Pane Title Enter the title to display on the item entry pane. 

Price Display Pane Level Select the sequence number (from 1 to 5) for the 
pane on which the user may view prices of the items 
on the sales order.  You may also select 0 – Not Used. 

Price Display Pane Title Enter the title to display on the item price pane. 

Availability Display Pane Level Select the sequence number (from 1 to 5) for the 
pane on which the user may view the current 
availability of the items on the sales order.  You may 
also select 0 – Not Used. 

Availability Display Pane Title Enter the title to display on the availability pane. 

Detail Display Pane Level Select the sequence number (from 1 to 5) for the 
pane on which the user may view detail of the prices, 
quantities, and delivery dates of the items on the 
sales order.  You may also select 0 – Not Used. 
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Detail Display Pane Title Enter the title to display on the detail pane. 

History Display Pane Level Select the sequence number (from 1 to 5) for the 
pane on which the user may view the list of items 
previously purchased by the customer from the sales 
order.  You may also select 0 – Not Used. 

History Display Pane Title Enter the title to display on the history pane. 
Transfer Order Select the sequence in which items will be transferred 

from the Matrix to the sales order.  You may select:  

• Item Order

• Description Order

• Shipment Date Order

• Entered Order

• Matrix Style Order

Style Entry Report Use this field to browse to the location of a Crystal 
Report to be made available on the Style Matrix 
window. 

Style Entry Report Button 
Name 

Use this field to provide the name of the button that 
will appear to launch the Sales Entry Report. 
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Entry Layout Tab 

This tab allows you to define the attributes that will be shown in the Sales Order Style Matrix. 

Allow for Searching in Entry 
Columns 

Check this box if you wish users to be able to search 
for valid values in the Matrix entry columns. 

Number of Quantity Columns Enter the number of columns to display for quantities 
on the Style Matrix.  This would be the maximum 
number of sizes that could be valid for item styles. 

Field Names In each row, select a field name representing one of 
the style attributes.  You will be selecting from the list 
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of user-defined fields from the Item Master.  The 
attributes should be entered in the order in which 
they are to appear on the Style Matrix screen. 
 
Note: All possible attributes should be included here, 
even those which will not be used for all items. 
 

Display Names In each row, enter the name for the field as you wish 
it to appear on the Style Matrix screen.  The field 
name that was entered when the UDF was created 
will appear on the Item Master; it is necessary to 
enter the same or a similar name here to have it 
appear correctly during order entry. 
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Pricing Options Tab 
 
This tab allows you to set options for the seasonal pricing feature.  If you do not wish to use this 
feature, leave all fields blank. 
 

 
 

Display Prices on Entry Tab Check this box if you wish to display the item prices at 
the bottom of each column on the Matrix entry tab.  
Note that doing so may result in slower performance 
of the system; prices will be visible in the Pricing and 
Detail panes regardless. 
 

Allow for Change of Price Check this box if users may change the item prices 
during Matrix entry. 
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Special Pricing in Sales Order 
Entry 

Check this box to enable Early Buy functionality. 

Title of Pricing Program Enter the title you wish to use for the seasonal pricing 
program; for example “Early Buy”. This is the field 
name that will be displayed in the Sales Order header 
screen. 

Header Field for Pricing 
Indicator 

Enter the name of the UDF in the Marketing 
Document Header which defines the seasonal pricing 
indicator (example AISMtxSeason). 

Add Entry Field to Sales Order Check this box to add an entry field on the sales order 
header to indicate whether the order will be eligible 
for seasonal pricing. 

Value to Indicate Inclusion Enter the value to display in the header UDF to 
indicate that the order will use seasonal pricing (for 
example, “Yes” or “Y”). 

Value to Indicate Exclusion Enter the value to display in the header UDF to 
indicate that the order will not use seasonal pricing 
(for example, “No” or “N”). 

Line Item Field for Pricing 
Indicator 

Enter the name of the UDF in the Marketing 
Document Rows which defines the seasonal pricing 
indicator (example AISMtxSeason). 

Value to Indicate Inclusion Enter the value to display in the row UDF to indicate 
that the item will use seasonal pricing (for example, 
“Yes” or “Y”). 

Value to Indicate Exclusion Enter the value to display in the row UDF to indicate 
that the order will not use seasonal pricing (for 
example, “No” or “N”). 

Header Field for Date 
Determination 

Enter the field ID for the field containing the date to 
be used for determining the pricing month for the 
order.  You may view the field ID by turning on View > 
System Information.  Note that the Delivery date is 
field 12. 
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Price List for Months For each of the 12 months, select the price list to be 
used for seasonal pricing for that month.  You may 
also select “Use Default SAP Price”.  If seasonal 
pricing is used, and a specific price list is selected for 
the month, then the prices from this list will override 
the price list attached to the customer, or any special 
pricing that has been defined for the customer, item, 
or quantity.  Note that months 1-12 represent the 
periods of the company’s fiscal year. 
 

Excel Button – Populate Item Master 
 
The “Excel” button at the bottom of the Style Defaults Entry screen will allow you to configure 
existing items with the required information for Resolv Style.  Note that it is required that you 
configure Excel to “Enable all macros” in order to use this feature. 
 
When you click on the “Excel” button, an Excel spreadsheet will open.  It will appear to be 
blank.  Go to View > Macros > View Macros.  Two macros will be shown: “Get All Items” and 
“Put All Items”. 
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Click on “Get All Items”.  The screen will display a list of all items in the Business One Item 
Master along with several blank columns.  You may use these columns to enter Resolv Style 
information about each item (see the section on configuring the Item Master later in this 
manual).   
 
 

 
 
 
When the entries are complete, display the macros again, and select “Put All Items”.  The Item 
Master will be updated with the information you have entered in the spreadsheet.  Note that 
all entries must conform to the valid values for each field. 
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Item Check 
 
 
Administration > System Initialization > Document Settings > Per Document Tab, Sales Order 
 
Be sure that the Automatic Item Availability Check is turned off in the system.  This feature of 
standard Business One is redundant when Resolv Style is used, and if it is turned on, it may 
cause errors when items are transferred from the Style matrix to the Sales Order. 
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Item Groups 

Administration > Setup > Inventory > Item Groups 

For each item group relating to items that will be used in the Style matrix, enter the expected 
lead time, in days.  This represents the number of days that are expected to elapse from the 
time an item is ordered from a supplier until it is received in the warehouse.  Resolv Style will 
use this figure when calculating the expected shipment date for backordered items. 
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Item Master 
 
Several fields have been added to the Item Master.  They are shown in the User-Defined Fields 
panel.  It is necessary to enter data in these fields for the item to be used correctly in the order 
entry Style Matrix. 
 

 
 

Style Column Display Enter the heading that will appear above the column 
for this size on the Style Matrix.   
 

Style Quantity Column Enter the column number for this size.  In general, the 
smallest size for a style should be in column 1, and 
each succeeding size should be in the next succeeding 
column.  Note that the maximum number of columns 
is set in the Style Defaults. 
 

Style Maximum Display 
Quantity 

Enter the maximum quantity of the item to display, if 
desired.  If a quantity is entered here, users will not 
see any quantity greater than this number as the 
quantity on hand, even if there is a greater quantity 
in the warehouse. 
 

Style Retention Percentage If desired, enter a percentage of the quantity of this 
item to be subtracted from the total available 
quantity displayed in the Style Matrix.  If entered, 
users will see a reduced quantity on hand in order to 
avoid the possibility of running out of stock. 
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Style Sort fields Four or more user-define fields for style attributes 
will be shown.  If you have changed the display names 
for these fields, the changed names will be shown.  
Others will appear as Style Sort 1, 2, 3, and 4. 
 
Enter the attributes for this item in the appropriate 
fields.  If valid values have been defined for the field, 
a drop-down list will provide the selection. 
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Seasonal Pricing 

It is common in the apparel industry, and in others where products are seasonal, for suppliers 
to offer special discounts in return for placing orders well in advance of the date needed.  For 
example, winter clothing would generally be received in the fall, but if the order is placed in the 
spring, then the supplier has advance notice of what he will need and in what quantity.  In 
return, he may offer discounts based on how far ahead the order is received. 

If you wish to offer this kind of discount pricing to your customers, you can utilize the seasonal 
pricing feature of Resolv Style.  Standard Business One pricing is based on price lists; each 
customer is assigned to a price list and sales order prices are set accordingly.  Alternatively, you 
can create special pricing, generally based on an existing price list, for the customer.  While it is 
possible to use various combinations of date ranges to vary the price of an item, the system 
only looks at the date on which the order is entered, not the date when it is due.  Resolv Style 
uses a different approach. 

You can set up price lists that are specific to various months of the year, relative to the delivery 
date of the items.  For example, create the following prices for item ABC: 

Price List Name Base Price List Factor Price 

Standard Price List $100.00 

3-month Price List Standard Price List 10% $  90.00 

6-month Price List Standard Price List 20% $  80.00 

In the Style Defaults, make the following settings (assuming that you begin in January and your 
fiscal year begins in January). 

Month Price List 

Month 1 (January) Standard Price List 

Month 2 (February) Standard Price List 

Month 3 (March) Standard Price List 

Month 4 (April) 3-month Price List

Month 5 (May) 3-month Price List

Month 6 (June) 3month Price List 

Month 7 (July) 6-month Price List

Month 8 (August) 6-month Price List

Month 9 (September) 6-month Price List

Month 10 (October) Use Default SAP Price 

Month 11 (November) Use Default SAP Price 
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Month 12 (December) Use Default SAP Price 

 
The result of this procedure is that if a customer places an order in January for delivery in 
January, February, or March, he will pay the standard price.  If he places an order in January for 
delivery in April, May, or June, he will pay the 3-month price.  If he places an order in January 
for delivery in July, August, or September, he will pay the 6-month price.  If the delivery date is 
in any other month, he will pay the price on his assigned price list, or his designated special 
pricing. 
 
Periodically, you can change the settings in the Style Defaults so that the pricing is appropriate 
for the month in which the orders are received.  For example, in March you can move the 3-
month pricing to June, July, and August, and so on. 
 
Points to remember: 
 

• The months in the Style Defaults are always based on your company’s fiscal year, not 
necessarily the calendar year. 

• In order to use Seasonal Pricing, you must check “Special Pricing in Sales Order Entry” 
box in the Pricing Options tab of the Style Defaults and fill in the other fields 
appropriately. 

• You must specify Seasonal Pricing in the Sales Order header for it to be applied to that 
order.  All rows will initially be set the same as the header. 

• You may activate or de-activate Seasonal Pricing on any row of a Sales Order once the 
items are entered. 

• Seasonal Pricing is only available on Sales Orders, not on Purchase Orders. 
• Blanket Sales Orders are legal contracts and will take precedence over standard SAP 

pricing and seasonal pricing. 
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Procedures  
 
Resolv Style is utilized during the Sales Order and Purchase Order entry process.  No other 
documents or screens in the system are affected. 
 
The prime objective of Resolv Style is to provide a quick, efficient, and accurate way for 
operators to enter Sales or Purchase Orders, when those orders are likely to consist of multiple 
sizes of the same item code.  Rather than entering the item code for each size on a separate 
line, it is possible to enter the attributes of each item type (style, color, etc.), and then enter the 
quantity for each size along a single row of a matrix. 
 
Additional functionality is provided which allows the operator to see the cumulative quantities 
of each size and style, pricing, availability, and the customer’s order history, all from the same 
set of screens.  This allows the operator to provide all information quickly to the customer, who 
may be on the phone while the order is being entered. 
 
Note that the appearance of the style Matrix is dependent upon the settings in the Style 
Configuration screen.  Which tabs are visible, their sequence, and the label of each tab are all 
subject to the settings in this screen.  The following sections illustrate the standard settings. 
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Sales Order Procedures 
 

Entering the Sales Order 
 
Begin by entering the Sales Order in the usual manner.  Enter the customer code or name, 
customer’s PO number, and requested delivery date in the header.  Verify or change the ship-to 
address and shipping method on the Logistics tab. 
 
If you use the seasonal pricing feature, be sure to set the header field to indicate whether this 
order qualifies for the seasonal prices. 
 

 
 
On the Contents tab, you may enter a single item at a time in the normal way, without entering 
the Style Matrix.  However, if you press TAB in the Item Number column and the check box 
“Use Matrix in Sales Orders” is turned on and “Automatically Start Style” check box is turned off 
in the Style Configuration, the screen will display the following message: 
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If you choose “Item”, you will see the usual list of items to choose from, and you may proceed 
to select one or more of them and enter one item code per row of the sales order. 

If you choose “Style”, the Style Matrix will open. 

On the Contents tab if you press TAB in the Item Number column and the check boxes “Use 
Matrix in Sales Orders” and “Automatically Start Style” are turned on in the Style Configuration, 
the screen will automatically open the Style Matrix. 

On the Contents tab if you press TAB in the Item Number column and the check boxes “Use 
Matrix in Sales Orders” and “Automatically Start Style” are turned off in the Style Configuration, 
the screen will NOT open the Style Matrix. 
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Style Matrix 

Item Entry Tab 
 
The following screen appears. 
 

  
 
Note: The columns on the left side of the grid display the attributes that have been defined in 
the system followed by the columns displaying the maximum number of quantity columns 
established in the Style Configuration.  Initially there are no headings above the quantity 
columns. 
 
At the bottom of the grid, “Style Pricing” will appear if seasonal pricing is used.  The item’s price 
will be displayed if “Display Prices on Entry Tab” was selected.  The field is editable if “Allow for 
Change of Price” was selected in the Style Configuration screen, Pricing Options.  A check will be 
displayed beneath the price when items are entered if seasonal pricing is applied to that item. 
 
Begin by entering a code in the first column, then tab to enter the remaining attributes for the 
item being ordered.  Once the style is entered, only valid entries will be permitted for the 
remaining fields; i.e., only colors and sizes that are available for that style are permitted.  Also, 
once the style code is entered, the appropriate labels will appear above the quantity columns. 
 
Continue to tab across the row, entering the quantity of each size that the customer is ordering. 
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Note: If you press TAB in a field, or make a partial entry, the search window will appear which 
will show valid values for the field (provided that “Allow for Searching in Entry Columns” was 
selected from the Style Configuration screen, Entry Layout tab). 
 
To enter additional rows, click on “Add Row”.  You may also highlight a row and duplicate it or 
delete it by clicking on the appropriate buttons. 



26 | P a g e R e s o l v  S t y l e  U s e r  G u i d e

The columns on the right of the matrix show the total quantity and total price for the items on 
that row.  The bottom of each quantity column shows the total quantity for each size, including 
all item codes. 
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Item Check 
 
At any point while you are in the matrix, you may click on “Item Check”.  The system will verify 
that all items have enough available quantity to ship on the requested date of the order.  If this 
is not the case, you will be able to see the next date when the item will be available, and you 
will be able to change the delivery date for that item.  The Item Check also locates any instances 
of duplicate items on the order. 
 
If all items are available and none are duplicated, you will see a message letting you know that 
all the items are available on the delivery date and are not duplicated. 

 
However, if there are backorders or duplicates, the Item Check screen will be displayed. 
 

 
 
The Item Check screen contains two grids.  The upper grid displays items that have been 
entered more than once on the order.  You may select one or more lines by using the 
checkboxes at the left, and then use the buttons under the grid to merge the lines, delete lines, 
or change the quantity on the lines. 
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The lower grid displays items that are not available to ship on the delivery date entered on the 
sales order.  Each line indicates the earliest date on which the items may be expected to be 
available for shipment. 
 
If there are open Purchase Orders that will fulfill the order, after first filling any other committed 

quantities of the item, then the expected delivery date of the Purchase Order will be displayed. 

 
If there are no open Purchase Orders, or if they will not be adequate to fill the order, the system 

will check the Lead Time for the Item Group of the item.  It will add one day to the lead time 

days, and then add that number to the current date.  The resulting date is displayed as the 

Backorder Complete date. 

 
If there are no open Purchase Orders, or if they will not be adequate to fill the order, and there is 

no Lead Time on the Item Group of the item, the system will enter the date “12/31/2049” as the 

Backorder Complete date.   

 
Highlight each line in turn and use the buttons below the grid to indicate the disposition of the 
backordered items. 
 

Change to Available 
Qty 

If a partial quantity is available to ship on the sales order 
delivery date, you may use this button to change the 
quantity of the item to the maximum available quantity.  
The remaining quantity will be omitted from the order. 
 

Backorder 
Remaining Qty 

If a partial quantity is available to ship on the sales order 
delivery date, you may use this button to ship the 
available quantity on the original delivery date and 
backorder the remainder until the next available date. 
 

Backorder Complete Use this button to backorder the entire quantity of the 
item until the next available date.  Items that have 
adequate stock will ship on the original delivery date of 
the order. 
 

Ship Complete Use this button to indicate that the order must be shipped 
complete, when all items are available.  The latest 
available date will then become the delivery date for all 
items on the order. 
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As each line in the upper and lower grid is rectified, the item disappears from the grid.  When 
the grid is empty, it will close. 
 
 

Note: The Item Availability Check screen will only be visible if “Use Item Availability 
Check” was selected. 
 
If “Require Availability Check” was selected, then if there are any backordered items 
on the order, you will not be allowed to exit from the matrix until an acceptable ship 
date has been entered for all items. 

 

Pricing Tab 
 

 
 
The Pricing tab displays the unit price of every size for the items that have been entered.  These 
prices are derived through standard Business One procedures, using the customer’s price list or 
special pricing, regardless of whether seasonal pricing is used or not.  It is not possible to edit 
the prices on this screen. 
 
This screen allows the operator to quickly quote prices of each item/size to the customer while 
taking the order on the phone. 
 
 
Note: You must highlight a line to see the column headings for the sizes. 
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Availability Tab 

The Availability tab shows the current available quantity of every size for the items entered. 

This screen allows the operator to quickly confirm quantities for the customer while taking the 
order on the phone. 

Note: You must highlight a line to see the column headings for the sizes. 
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Detail Tab 
 

 
 
This screen allows you to see the order in detail as it will appear on the completed Sales Order.  
Each item code is shown on a separate row, along with its quantity, price, and expected ship 
date.  Operators can use this screen to check that each item is entered correctly and priced 
correctly.  Prices may be changed, if “Allow for Change in Prices” was selected. 
 
Note: If the Item Check has been performed, this screen will indicate which items have been 
backordered, and what their current expected delivery date will be. 
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Order History Tab 
 

 
 
This tab provides the operator with a detailed list of the customer’s previous purchases.  The 
list can be re-sorted by clicking at the top of any column.  You may use the drill-down arrows to 
see the actual documents on each row. 
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Completing the Sales Order 

Once items are entered in the Style Matrix, click on the “Transfer” button to transfer the entries 
to the actual Sales Order document.  The system creates one line per item code in the Contents 
tab of the Sales Order. 

If the seasonal pricing feature is used, you may change the indicator either at the header level, 
for the entire document, or individually by line.  Prices will change accordingly when you do so. 

At this point, all normal Sales Order entry procedures may be used.  You may make any changes 
desired in the rows that have been entered, or in the header or other tabs of the document.  
You may also return to the Sales Order to make changes at any time, as long as it remains open. 

Note: You may add more lines to the sales order by typing or searching for a new item code.  
You may open the Style Matrix again by using the TAB key in the item number column, as 
before.  However, the matrix will open in a blank state, for new items to be entered.  It is not 
possible to re-open the matrix with the existing items to make any changes there. 

When all additions and changes are complete, click on “Add” to enter the Sales Order. 
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Purchase Order Procedures 
 

Entering the Purchase Order 
 
Begin by entering the Purchase Order in the usual manner.  Enter the vendor code or name, 
and the requested delivery date in the header.  Verify or change the ship-to address and 
shipping method on the Logistics tab. 
 
Note: Seasonal pricing does not apply to Purchase Orders. 
 

 
 
On the Contents tab, you may enter a single item at a time in the normal way, without entering 
the Style Matrix.  However, if you press TAB in the Item Number column, the screen will display 
the following message: 
 

 
 

If you choose “Item”, you will see the usual list of items to choose from, and you may proceed 
to select one or more of them and enter one item code per row of the sales order. 
 
If you choose “Style”, the Style Matrix will open. 
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Style Matrix 

Item Entry Tab 
 

 
 
 
Note: The columns on the left side of the grid display the attributes that have been defined in 
the system.  The following columns display the maximum number of quantity columns 
established in the Style Defaults.  Initially there are no headings above the quantity columns. 
 
At the bottom of the grid, the item’s price will be displayed if “Display Prices on Entry Tab” was 
selected.  The field is editable if “Allow for Change of Price” was selected in the Style 
Configuration screen, Pricing Options.   
 
Begin by entering a code in the first column, then tab to enter the remaining attributes for the 
item being ordered.  Once the style is entered, only valid entries will be permitted for the 
remaining fields; i.e., only colors and sizes that are available for that style are permitted.  Also, 
once the style code is entered, the appropriate labels will appear above the quantity columns. 
 
Continue to tab across the row, entering the quantity of each size that the customer is ordering. 
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Note: If you press TAB in a field, or make a partial entry, the search window will appear which 
will show valid values for the field (provided that “Allow for Searching in Entry Columns” was 
selected from the Style Configuration screen, Entry Layout tab). 

To enter additional rows, click on “Add Row”.  You may also highlight a row and duplicate it or 
delete it by clicking on the appropriate buttons. 

The columns on the right of the matrix show the total quantity and total price for the items on 
that row.  The bottom of each quantity column shows the total quantity for each size, including 
all item codes. 

Note: The Item Check feature is not available for Purchase orders. 
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Pricing Tab 

The Pricing tab displays the unit price of every size for the items that have been entered.  These 
prices are derived through standard Business One procedures, using the vendor’s price list or 
special pricing.  It is not possible to edit the prices on this screen. 

Note: You must highlight a line to see the column headings for the sizes. 



 
 

38 | P a g e    R e s o l v  S t y l e  U s e r  G u i d e  

 

Availability Tab 
 

 
 
 
The Availability tab shows the current available quantity of every size for the items entered. 
 
This screen allows the operator to quickly verify the quantities that are needed for each size. 
 
Note: You must highlight a line to see the column headings for the sizes. 
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Detail Tab 
 

 
 
This screen allows you to see the order in detail as it will appear on the completed Purchase 
Order.  Each item code is shown on a separate row, along with its quantity, price, and expected 
ship date.  Operators can use this screen to check that each item is entered correctly and priced 
correctly.  Prices may be changed, if “Allow for Change of Price” was selected from the Style 
Configuration screen, Pricing Options tab. 
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Order History Tab 
 

 
 
This tab provides the operator with a detailed list of the company’s previous purchases from 
this vendor.  The list can be re-sorted by clicking at the top of any column.  You may use the 
drill-down arrows to see the actual documents on each row. 
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Completing the Purchase Order 
 
Once items are entered in the Style Matrix, click on the “Transfer” button to transfer the entries 
to the actual Purchase Order document.  The system creates one line per item code in the 
Contents tab of the Purchase Order. 
 

 
 
At this point, all normal Purchase Order entry procedures may be used.  You may make any 
changes desired in the rows that have been entered, header section or other tabs of the 
document.  You may also return to the Purchase Order to make changes as long as it remains 
open. 
 
Note: You may add more lines to the Purchase Order by typing or searching for a new item code.  
You may open the Style Matrix again by using the TAB key in the item number column, as 
before.  However, the matrix will open in a blank state, for new items to be entered.  It is not 
possible to re-open the matrix with the existing items to make any changes there. 
 
When all additions and changes are complete, click on “Add” to enter the Purchase Order.  


